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An Intfroduction to
Windows 3

Microsoft shipped its first version of Windows in November of 1985. However, it was
not until 1990, almost 5 years later, with the introduction of Windows 3, that it began to
receive mainstream acceptance. Why? What makes Windows 3 more special than any
previous version of Windows? Perhaps the answer lies in the fact that Windows 3 offers
the most extensive feature set of any version of Windows so far.

This chapter introduces you to the significant features in Windows 3. You'll learn about
such things as the advanced memory management features in Windows, how it interacts
with DOS applications, how it multitasks, and so on. However, on the lighter side, this
chapter begins with an historical account of Windows. This account will give you some
background on where Windows has been and where it stands now. Along the way, you
might develop your own opinion, if you haven’t already, as to why Windows 3 is the best
selling IBM-PC software application since Lotus 1-2-3.

THE DEVELOPMENT OF WINDOWS:
A BRIEF HISTORY

The first version of Windows was a long time in coming. Microsoft first announced its
plans for the product in November of 1983. However, it was not until two years later, in
November of 1985, that Microsoft actually shipped the first version of Windows,
Windows 1.01.
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From the beginning, Microsoft has staunchly supported the concept of a graphical user
interface (GUI), and Windows is their expression of that vision. The historical account
that follows traces the evolution of that interface from the first version of Windows up
to Windows 3. However, as you'll soon see, there is a great deal more to Windows than
just a graphical interface. In fact, each version of Windows represents a significant stride
in the evolution of software for the IBM PC.

Windows 1

When Version 1.01 of Windows shipped in November of 1985, it made quite a splash.
Part of this was due to the anticipation of Microsoft’s finally shipping this long-awaited
product. Another aspect was the competition that was going on between Windows and
GEM, Digital Research’s GUI environment. However, most of the attention centered
around Windows features.

Windows 1.01 offered a unique form of graphical user interface. It represented
something of a marriage between the graphics and character-based worlds. The main shell
for Windows was the MS-DOS Executive, prevalent in all versions of Windows up until
Version 3.0. The MS-DOS Executive window was composed of a menu bar with
pull-down menus along the top and disk drive icons below, which you could use to quickly
switch to the different drives on your system. Beneath this, all the files in the current
directory were listed. You could start any Windows application by simply double-click-
ing on its executable filename. Windows also came with multiple applications (Write,
Paint, Notepad, and so on) which you could run (multitask) at the same time, each in its
own window. Figure 1-1 shows an example of what Windows 1.01 looks like.

You could also run DOS applications in Windows 1.01, though you couldn’t multitask
them. Each DOS application required a PIF (Program Information File), a special file
that provided Windows the information it needed to run a DOS application.
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Figure 1-1 An example of Windows 1.01
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Thus, Windows 1.01 (as well as other versions of Windows since that time) relied on
the user for a basic working knowledge of DOS drives, paths, and file-naming conven-
tions. Unlike some GUI products, Windows never has (and hopefully never will)
completely insulate the user from the underlying DOS platform.

Windows 1.01-also had a unique approach to memory management. Although it was
limited to running.in real mode beneath the 640K barrier, it was also capable of
consolidating free memory that was fragmented by starting and quitting multiple appli-
cations.

Windows 1.01 was also capable of discarding program code when memory became
tight. That is, if a Windows program was too large to fit in memory, Windows 1.01 could
discard code from other Windows programs and read that code back into memory again
from the programs’ .EXE files when needed. Windows 1.01 was also capable of running
more than one instance (copy) of the same Windows program, and both instances would
share segments of the same code.

The architecture of Windows 1.01, like all versions of Windows, was based on a
messaging system. Each Windows application was responsible for receiving and respond-
ing to messages sent to it by Windows’ central messaging system. Through this messaging
system, Windows is capable of communicating with, and controlling, multiple applica-
tions at the same time.

The Windows messaging system was, and is, event driven. That is, when an event of
interest occurs, such as a mouse click or a keyboard entry, Windows generates a message
to that effect and sends it through its central message queue. So how does Windows know
which application to pass that message to? Actually, Windows doesn’t make this decision,
you do. When you focus your attention on an application by giving it mouse or keyboard
input, you also focus the attention of Windows on that application. That application is
then responsible for checking the Windows central message queue and acting on any
messages that may be there. In fact, while a Windows application is active, it is constantly
checking the message queue and reacting to messages, until you activate another
application.

Windows 1.01 also offered something else that was new at the time for the IBM
PC—device independence for applications. Most DOS applications came, and still come,
with a disk that includes device drivers for the support of different displays, printers,
plotters, keyboards, mice, and so forth. Windows, however, came, and still comes, with
these device drivers already provided. To do this, Microsoft developed a device-indepen-
dent graphics interface—the Graphics Device Interface or GDI—that allows application
developers to display graphics and formatted text within their applications. Through the
GDI, Windows itself is responsible for passing this information on to the system
hardware. Therefore, if you purchased an application designed for Windows, you didn’t,
and still don’t, have to worry about what hardware that application supports. It automat-
ically supports all the hardware supported by Windows.

Windows 1.01 had its share of limitations, though. For one thing, the windows in which
its applications ran were always in tiled configuration, similar to Figure 1-1. This
“automatic tiling” feature was built into the product based on studies that had been done
which indicated that it reduced the amount of work required of the user when first opening
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an application. However, because of this feature, you could not overlap application
windows, nor could you easily resize or move them about the screen.

Windows 1.01 suffered from something else that has plagued the Windows project
since its inception—the disparity between the capabilities of software and the slow
evolution of hardware required to run that software. At the time Windows 1.01 was first
introduced, many users were still running systems with two floppy-disk drives. There
were more than a few XTs out there with hard disks, of course, and the occasional AT,
but most users just didn’t have the RAM or the disk space needed to make Windows
really perform as it should.

Windows 2

Believe it or not, Windows got its first real boost in 1987 when Microsoft and IBM jointly
announced OS/2 and Presentation Manager. Development of this operating system and
its associated graphical user interface actually led to the development and introduction
of Windows 2.01.

Part of the significance of Windows 2.01 was that it conformed to the Systems
Application Architecture (SAA) standard developed by IBM for the Presentation Man-
ager portion of OS/2. This standard proposed a uniform system of windows, menus, and
dialog boxes for managing an application. To this day, a copy of the SAA literature ships
with every copy of the Windows Software Development Kit (SDK). This kit includes
software tools that developers can use to develop Windows applications. Further,
Microsoft itself adheres to the SAA standard, where appropriate, both for Windows itself
and for applications developed by Microsoft for Windows.

Conforming to the SAA standard allows users to transfer their skills from one
application to the next. For example, most Windows applications have a File Open
command. Selecting this command results in the display of a dialog box that lets you
open a data file for an application. Although the content of this dialog box may vary
slightly from one application to the next, it performs basically the same function and
operates in largely the same way. Therefore, a user need not learn a new command, nor
a different interface style, when using the File Open command in different Windows
applications.

Version 2 also represented an improvement in the Windows graphical user interface.
For one thing, it supported overlapping windows. (Figure 1-2 shows an example of
Windows 2.) Notice in that figure that the Notepad window overlaps the Cardfile window.
To create this figure, the Notepad window was sized and then moved on top of the Cardfile
window, a significant enhancement indeed. Version 2 also included a number of other
enhancements to the keyboard and mouse interface for menus and dialog boxes.

Windows 2 also marked the first version of Windows that included Dynamic Data
Exchange (DDE). DDE allowed Windows applications to communicate with one another,
via the messaging system, for the purpose of exchanging blocks of data.

Windows 2, however, was not without its problems. As always, there was the hardware
problem. You needed the equivalent of an AT-class machine with 640K to run it. You
could run it on a lesser machine, but it was doggedly slow. Also, Windows 2 had difficulty
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Figure 1-2 An example of Windows 2

running many of the popular DOS applications of the day. In general, those applications
that wrote directly to the screen, used graphics, or controlled the keyboard could not be
run in a window. In addition, some of these applications even had difficulty running full
screen.

Windows/286 and Windows/386

Another big boost for Windows came with mainstream acceptance of the 386 PC.
Windows/386, introduced in 1987, took advantage of the “virtual 8086 mode of the
80386 processor, at a time when few other applications did. This meant that DOS
applications and Windows applications could now be multitasked, each DOS application
in its own 640K virtual machine. Thus, for the first time, you could multitask DOS
applications along with your Windows applications. (See “Multitasking,” later, for a
further discussion of how Windows multitasks.)

In that same year (1987), Microsoft re-introduced Windows 2 and re-christened it
Windows/286. In this version, Windows could access 64K of extended memory above
the 640K available through DOS and still run in real mode. Thus, the power of the 80286
machine was further exploited and the operation of Windows further enhanced.

However, despite these dramatic improvements, enthusiasm for Windows was on the
wane in the late 1980s. Frankly, there just weren't that many “killer” applications
available for it. In fact, Windows was relegated to something of a niche phenomenon and
wasn't given serious consideration by many of the big software houses. However, some
companies, including Aldus and Micrografx as well as Microsoft, continued to develop
aggressively for Windows. Further, Windows kept showing up undemeath major appli-
cations. Many people were surprised to learn that their copy of Microsoft Excel or Aldus
Pagemaker was actually running on top of a run-time version of Windows. In short, they
had been running Windows all along and didn’t know it.
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Windows 3

Windows 3, introduced in May of 1990, represents the culmination of years of hard work
at Microsoft. It implements all the best features from previous versions of Windows as
well as a host of new features. Perhaps this version of Windows marks the beginning of
what Microsoft really had in mind all along.

The features in Windows 3 address most of the problems that have plagued Windows
in the past. Perhaps the most exciting of these features, though, is the new memory
management scheme.

Windows 3 unlocks the power of your 80286 or 80386 computer by accessing the
protected-mode capabilities of these processors. Thus, if extended memory above the
640K of conventional memory is available, Windows 3 is capable of accessing that
memory directly. Further, you don’t have to purchase a specific version of Windows for
your particular machine. Instead, Windows 3 is capable of running in one of three
different modes (real, standard, or 386 enhanced), depending on the type of processor in
your machine and the amount of memory you have. When you install Windows, it figures
out what processor you have, as well as your available memory, and configures itself
accordingly. When you start Windows, it automatically comes up in the mode that is best
suited to your particular system.

The graphical user interface in Windows has also been further refined. In fact,
Windows has a whole new look, as shown in Figure 1-3. Instead of the old MS-DOS
Executive, so prevalent in previous versions, Windows 3 uses Program Manager, an
entirely new shell that presents your applications as icons. You can run any application
by simply double-clicking on its icon. However, true to the tradition of Windows,
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Figure 1-3 The Windows 3 Program Manager
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Program Manager does not completely insulate you from the DOS. In fact, the purpose
of each of the icons in Program Manager is to initiate a specific DOS command.

You can also run a mixture of Windows and DOS applications at the same time with
Windows 3. If Windows is running in 386 enhanced mode, you can run multiple DOS
applications at the same time, each in its own window, and switch back and forth between
them. .

Windows 3 also includes a whole host of other powerful new features. However, to
give you a complete rundown of all the new features in Windows 3 would be to steal
thunder from the rest of this chapter, as well as the rest of this book. Suffice it to say that
although Windows 3 is a powerful product, it is also a very complex one. The purpose
of this book is to give you the insight you will need to deal with that complexity.

In concluding the history of Windows, one final point should be made. For the first
time in the history of the Windows project, the timing is right. The average user has
evolved to the point where he or she is capable of appreciating the benefits of running
multiple applications at the same time. Further, the hardware and software are finally in
sync. Now, 286 and 386 computers with one or more megabytes of memory and larger
hard disks have become the norm instead of the exception. In addition, powerful Windows
applications exist in abundance, with more becoming available all the time. At last,
Windows is ready to receive the mainstream acceptance that it so richly deserves.

WINDOWS 3 FEATURES

The sections that follow discuss many of the more salient features in Windows 3. Most
of these features will be discussed on an introductory level, and you will be pointed to
other chapters in this book for additional detail. Practically every feature discussed here
will affect you as a Windows user at one time or another.

Before delving into the major features of Windows 3, though, it is important that you
have at least a passing understanding of the extent of the relationship between Windows
and your system. As you know, you start Windows as you would any other DOS
application. However, once it’s up and running, it takes over many of the functions that
are normally attributable to a full-blown operating system. For example, it is responsible
for handling the video display, the keyboard, the mouse, printers, I/O ports, and memory
management. It also controls the execution and scheduling of all programs that you run
from within Windows. In short, a great deal happens when you type WIN and press
ENTER.

Advanced Memory Management

As mentioned, one of the most exciting aspects of Windows 3 is its advanced memory
management capabilities. Windows 3 is capable of running in one of three different
modes: real, standard, or 386 enhanced. The mode in which Windows runs depends on
the type of processor in your machine and its available memory. When you install
Windows, it checks your system resources and configures itself to run in a particular



Aporia is a shareware program from New Tools, Inc. that offers an alternative interface
for Microsoft Windows. It combines many of the same functions as Program Manager
and File Manager—launching programs and managing files—into a single package.
Therefore, you might want to use it as a replacement for these two shells. However, unlike
most Windows applications, which offer both a mouse and keyboard interface, Aporia
caters primarily to the mouse.

Aporia provides an object-oriented approach to managing Windows. Like Program
Manager, it presents program objects as icons. However, Aporia’s icons are not confined
to group windows. Instead, you can position them freely about the Windows desktop.
Further, in Aporia, icons are called tools. The term “tool” is used to refer both to the icon
itself and to the object that you attach to that icon. Objects can include such things as
Windows or DOS applications, data files, directories, batch files and so on.

Aporia’s tools are dynamic—that is, you can have them interact with one another. For
example, you can use your mouse to drag a tool representing a data file onto another tool
that represents an application. Aporia will then start that application and load the data file
you specified.

Aporia also allows you to organize your tools into groups. One of the more commonly
used tools in Aporia is called a desk. Desk tools are used to store groups of related tools.
You can create multiple desks, each with a different name. In each desk, you can place
one or more tools as well as other desks. For example, you could have a top-level desk
called “Documents.” Within this desk, you might have other desks like “WordPerfect”

607
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and “WordPerfect Files” or “Word for Windows™ and “Word Files.” To set up this sai
arrangement in Program Manager, you would either have to create one large gre
window or several smaller ones.

If you feel constrained by Program Manager and File Manager, Aporia may offer y¢
a more free-form style of interface for organizing your desktop. '

Note: Aporia is not public domain software—it is being distributed through this be
as “shareware.” See Appendix A for information on how to install Aporia and
summary of the registration procedure for the program.

APORIA BASICS

To install Aporia, you must run the Windows 3 Power Tools Setup program. (The use
this program is described in Appendix A.) This program copies Aporia’s program
to a special directory on your hard disk, usually \AP-SETUP. Once this ‘
completed, the Power Tools Setup program then runs Aporia’s own version of Se
This program, in turn, lets you choose the names of various directories in which
program files will ultimately be installed. (See Appendix A for a complete
what these directories are.) Nevertheless, as a final step, the Aporia Setup program cre
a Program Manager group window (entitled Aporia) and places an icon for the prod
in that window. Therefore, to run Aporia, you need only open this group window
double-click on the Aporia icon.
The first time you run Aporia, it will give you an opportunity to create a separate d
tool for each of your current Program Manager group windows. If you elect to t
advantage of this option, it will present a dialog box showing the names of each of y¢
Program Manager group windows. You can then select the ones you want. Aporia W
then create a separate Desk Tool for each group window that you select. Within the
desks, Aporia will place User Tools for each application in the group. This allows yo
get a quick start with Aporia by creating tools for each of your applications. '

The Default Tools

When you start Aporia, it displays a default set of tools on the Windows d&skxop,
in Figure 16-1. (You'll notice that the Program Manager window has been minimi
an icon, so that Aporia’s tools are easier to see.) Each of the default tools is represe
by an icon. Briefly, these tools perform the following functions:

® Tree: One of the most commonly-used tools in Aporia. You can use this ool
manage the files and directories on your hard disk. The use of the tool is cover
in various spots throughout this chapter. }

® Desk: The initial default desk tool for Aporia. This desk contains the default te
that are initially displayed by Aporia. You can, of course, add new tools or de
to this desk or create additional desks. See “Creating Desk Tools™ later fo
description of how you can use desk tools to organize your desktop.
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Figure 16-1 Aporia displays Tools on the Windows desktop that allow you to start
applications and manage files and directories

® Trash: Lets you discard old and unneeded tools and erase their associated files on
disk. All files that you delete with the aid of this tool are actually copied to a special
\!TRASH directory on your hard disk. That way, if you change your mind, you can
easily recover a file. However, if you leave Aporia without restoring the file, it will
be gone forever. See “Removing Tools™ later in this chapter for details on how to
use this tool.

® Help: Provides access to on-line help for Aporia. See “Getting Help” later in this
section for a description of how this tool is used.

® Notes: Lets you attach descriptive notes to Tools. See “Keeping Notes™ later in this
chapter for information on how to use this tool.

® Dir: Opens a Directory window that shows the files in the current directory. You
can create and display up to 16 Directory Tools on the Windows desktop at any one
time, each representing a different directory on your hard disk. Directory windows
contain a special menu that lets you manage files (copy, move, rename, and delete
them), sort the files in a directory, and create new User Tools.

® Copy: Lets you make copies of tools. See “Copying Tools™ later for details on using
this tool.

® Hide: You can use this tool to hide other tools that are displayed on the desktop.
You can use this tool to help you avoid a cluttered display. See “Hiding Tools™ later
for information on how to use this tool to hide others.
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® Opt: Lets you set various options for a tool. For example, you can ct
of the tool as well as its icon. Aporia comes with an assortment of icons f
you can choose. You can also use this tool to change the default settin;
See “Customizing Tools™ later for a description of the various options )
for a tool. {

e Size: Lets you set the relative size and position of an application window.
each time you start an application, its window will always be displayed
size and position on the desktop. See “Using the Size Tool™ later for a
of how to use this tool.

The Aporia Menu

Unlike most Windows applications, Aporia does not run in a window. Instead
start Aporia, its tools are displayed on the Windows desktop. The only other e
Aporia is its icon, which appears at the bottom of your screen. When you el
icon, a window Control menu is displayed, as shown in Figure 16-1. Because /
not run in a window, all of the standard window manipulation commands
Minimize, and so on) appear greyed, meaning you cannot select them. He
following menu options are available:

® Close: Closes Aporia, removing all its tools from the desktop. You can:
ALT+F4 key sequence as an alternative to this option. '

® Switch To: Displays the Windows Task List window, allowing you |
switch to a different application. i

® About: Opens a dialog box that tells you all about Aporia and how you e
a registered user. !

e Save Tools: Saves the tools that are currently displayed on the desktof
this is done when you close Aporia or when you leave Windows. Hi
option allows you to guard against any data loss as the result of a

® Load Tools: Allows you to set up tools for each of the applications in ye
Manager group windows. A dialog box is displayed showing the na
current group windows. You can select one or all of the names in the
will then create a separate desk for each group window containing tools
each application in the group.

L

® Memory Status: Displays a dialog box showing the free memory
Aporia.

e Blank Now: Immediately turns on the Aporia screen blanker. The Win
disappears momentarily and a small graphics image is displayed
(Otherwise, by default, Aporia blanks the screen after five minutes of

Moving Tools

Aporia’s tools can be moved to any location on the desktop by simply
tool and dragging it to its new location. To do this, begin by moving the:
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Figure 16-2 The “hot spot” for an Aporia tool is located in the upper-left corner of
its icon

onto any tool. You'll notice that the shape of the mouse pointer changes to a hammer.
When you click your mouse, the shape of the pointer changes to a pair of pliers. At that
point, you can move the tool by simply dragging it to a new location and then releasing
your mouse button.

Running Tools

You can run any tool by simply double-clicking on it. For example, if you have set up a
tool representing an application, you can start that application by simply double-clicking
on its tool. Alternatively, you can drag one tool on top of another. For example, as you'll
soon see, you can create a user tool that represents a data file on your hard disk. Once
that tool exists, you can drag it on top of an application tool and release your mouse button
to have Aporia start the application and load that data file.

When you drag one tool on top of another, Aporia is rather particular about where you
place the tool that is being dragged. The upper-left corner of each tool is referred to as
the “hot spot,” as indicated in Figure 16-2. You must position the hot spot of the tool you
are dragging squarely on the tool you are dragging it to. Otherwise, if you just cover one
tool with another, Aporia will respond by simply moving the tool you are dragging, and
nothing will happen.

Getting Help

Aporia also offers an on-line help facility. However, Aporia does not use the standard
Windows help program. Instead, through its Help tool, Aporia offers a series of windows
that provide helpful information about each of its respective tools. For example, imagine
you want to get help with the Tree tool. To do this, grab the Tree tool with your mouse
and drag its upper-left corner on top of the Help tool. Aporia opens up a window that
provides general information about how to use the Tree tool.

You can also set up custom help files for Aporia’s Tools. For example, later, under
“Creating User Tools,” you’ll learn how to create tools that represent applications and
data files on your hard disk. To create a help file for one of these tools, simply drag it on
top of the Help Tool. Aporia opens Notepad and passes it a parameter that includes the
name of the tool followed by a .HLP extension. For example, if the name of the tool is
WP.EXE, Aporia passes Notepad the parameter WP.HLP. If this Help file already exists,
Notepad opens the file and displays it. On the other hand, if the file has not as yet been
created, Notepad will inform you of this and give you an opportunity to create it. Once
the file is displayed, you can type as much or as little text as you need. When you are
done, save the file and close Notepad to return to Aporia. The next time you drag that
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same User Tool onto the Help Tool, Aporia will open Notepad and load the Help file
you've just created.

Aporia also comes with two files, APORIA.INT and APORIA.MAN, that you can load
into Write. APORIA.INT provides a topical tutorial-like approach to showing you how
to use Aporia. APORIA.MAN, on the other hand, is a reprint of the Aporia manual
without the illustrations.

USING TOOLS

As mentioned, Aporia is based on the concept of tools. Each tool is represented by an
icon that is displayed on the Windows desktop. Aporia’s tools can be used to represent
programs, data files, and directories on your hard disk. Although Aporia comes with its
own set of default tools, you can also create your own tools and link them to your
applications, data files, and directories. In addition, you can organize tools into groups
called desks. When you open a desk, its tools are displayed on the Windows desktop for
your use. Conversely, when you have finished using the tools in a desk, you can close
the desk, thereby removing its tools from the Windows desktop.

Aporia tools are separated into three groups: User Tools, Directory Tools, and Desk
Tools. User tools provide access to your applications and their data files. Directory tools
are used to provide access to specific directories on your hard disk. Desk tools are used
to organize User Tools and Directory Tools into meaningful groups. The sections that
follow show you how to create each of these kinds of tools.

Creating User Tools

To create user tools that represent applications and data files on your hard disk, you can
use the Tree tool. When you double-click on this tool to run it, Aporia opens the Directory
Tree window shown in the upper-left comer of Figure 16-1. This window contains a
diagram of the directories on the current drive. Double-click on the name of directory
that contains the executable file for one of your applications. For example, if you use
WordPerfect as your word processor, you might double-click on the directory that
contains WP.EXE. (You may have to use the Drives menu to change the drive for the
Directory Tree window so that the appropriate directory is displayed on the directory
tree.)

When you double-click on the name of a directory in the Directory Tree window,
Aporia opens a Directory window displaying the names of files in that directory, as shown
in Figure 16-3. This window is usually displayed immediately to the right of the Directory
Tree window. Use the scroll bar to scroll the contents of the Directory window until the
name of the executable file for your application appears, then click on the name of that
file to select it. When you are ready, select the Special Make User Tool command from
the Directory window'’s menu. Aporia hesitates for a moment and then creates a new user
tool representing that application on the Windows desktop. The name of the executable
file—for example, WP. —appears as a description for the tool. You can now run the
application by simply double-clicking on its tool.
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Figure 16-3 You can use Directory window to display the names of files in a
directory and to create User Tools

Note: As an alternative to using the Special Make User Tool command to create a user
tool, you can simply double-click your right-hand mouse button on the name of
a file in a Directory window.

You can also create tools that represent data files for your applications. For example,
imagine you want to create a user tool that represents a data file for the application user
tool you've just created. To do this, double-click on the name of a directory in the
Directory Tree window (left side of Figure 16-3) that contains the file you want to use.
Aporia opens a second Directory window showing the files in the directory you've
selected. Highlight the name of the data file you want to use and select the Special Make
User Tool command. Aporia creates a tool that represents that data file.

If you’ve been following along, you now have two brand new User Tools displayed
on the Windows desktop, one representing an application and the other representing a
data file for that application. To give you an example of the interactive power of Aporia,
drag the user tool for the data file onto the user tool for the application. Remember to
locate the hot spot (the upper-left corer) of the data file’s icon squarely on top of the
icon for the application. When you release your mouse button, Aporia runs the application
and automatically loads the data file into that application.

Note: See “Managing File and Directories” later in this chapter for additional ways you
can use the Directory Tree window to manage the directories on your hard disk.
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Tip: Running data files

You can also “run” a data file. That is, you can double-click on a User Tool that
represents a data file. When you do this, Aporia loads the application that cre-
ated the data file and then loads the data file into that application.

Creating Directory Tools

Directory Tools give you immediate access to the files in a specific directory without
your having to use the Directory Tree window. When you run a Directory Tool by
double-clicking on it, Aporia opens up a Directory window showing the files in a specific
directory. This has two advantages. One the one hand, it has the effect of making that
directory the current directory for Aporia’s operations. On the other hand, it gives you
instant access to the files in a specific directory without your having to navigate through
the directory trees.

To create a Directory Tool, you must use the Tree Tool. Double-click on this tool to
open the Directory Tree window (provided that it isn’t open already) and select the name
of a directory from the directory tree. When you are ready, select the Special Make
Directory Tool command from the menu in the Directory Tree window. Aporia creates
a Directory Tool for the directory that is currently selected in the directory tree and
displays it on the Windows desktop. You can now double-click on that tool to open a
Directory window for the directory whenever you want.

Note: As an alternative to the Special Make Directory Tool command, you can simply
double-click your right-hand mouse button on the name of a directory in the
Directory Tree window. Aporia will then create a Directory Tool for that
directory.

Directory tools have a number of uses beyond that of simply opening a Directory
window for a specific directory. For example, you can use a Directory Tool to make a
specific directory current when you start an application. Earlier in this chapter you were
encouraged to create a User Tool for one of your applications. If you want, you can drag
the tool for that application on top of the Directory Tool you've just created. Aporia will
make the directory represented by the Directory Tool the current directory for that
application. You can then run the application by double-clicking on it, as usual.

You can also drag a User Tool that re ts a data file onto a Directory Tool. This
has the effect of copying the data file to the directory that is represented by the Directory
Tool. See “Copying Files™ later in this chapter for additional ways you can copy files
with Aporia.

Note: A special Directory Tool is included in Aporia’s default tool set. The name of
this tool is simply Dir (Directory). Although it is a Directory Tool, it is not
attached to any specific directory. When you run this tool by double-clicking on
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File View Special
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Figure 164 You can also use the Dir (Directory) Tool to open a Directory window

it, Aporia opens a Directory window for whatever directory happens to be current
at the time. Figure 16-4 shows an example Directory window that was displayed
by running the Dir Tool. Notice that in addition to the name of each file, this
Directory window shows the size of each file in bytes, its date and time of
creation, and any attribute that is currently assigned to the file. You can have any
Directory window display file information in this way, if you so desire. See
“Using the View Menu” later in this chapter under “Managing Files with
Directory Windows™ for details on how you can do this.

Copying Tools

You can use Aporia’s Copy Tool to create replicas of existing tools. This is an easy way
to create a new tool without using either the Directory Tree window or using a Directory
window. For example, imagine that you want to create a new desk to store a new set of
tools you are creating. To do this, drag the tool labeled Desk (located in the upper-right
corner of your screen) on top of the Copy Tool. (Remember to locate the hot spot for the
Desk Tool—its upper-left corner—squarely on top of the Copy Tool.) Aporia creates a
new Desk tool with the same icon and the same description. In a moment, you'll learn
how to store other tools in this desk and to change the name of this desk so that you can
differentiate it from other desks you create.

Creating Desk Tools

Desk Tools allow you to organize your User Tools and Directory Tools into meaningful
groups. In addition, you can store one Desk Tool within another, allowing you to create
multiple layers of desks and access all of them from a single Desk Tool. Aporia’s Desk
Tools are often referred to simply as “desks,” for short.
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Aporia’s default set of tools are stored under a single Desk Tool, labeled simply Desk.
By default, this tool is located in the upper-right corner when you first start Aporia. Any
new User or Directory Tools you've created up to this point are also associated with this
desk. To give you an idea of what this means, double-click on this Desk Tool. All the
tools displayed on your screen except the Hide Tool disappear from your screen. In effect,
you have just put away the tools for that desk. To make your tools reappear, double-click
on this tool a second time. The tools associated with that Desk Tool are restored to the
Windows desktop.

Creating New Desks

To create a new desk, you use the Copy Tool as described above to make a replica of
Aporia’s default Desk Tool. Once the new desk is created, you can later change its name
so that you can differentiate it from your other desk tools. See “Customizing Tools” later
for details on how you can change the name of a tool.

Storing Tools in Desks

To store a User or Directory Tool in a Desk Tool, simply drag that tool onto the
appropriate Desk Tool. Aporia displays the dialog box shown in Figure 16-5, asking you
to confirm the operation. Select OK to have Aporia store the tool in the desk. The next
time that you double-click on that Desk Tool, Aporia will remove the User or Directory
Tool from the desktop and store it in the Desk Tool.

You cannot store the same tool in two different desks. If a tool is already stored in one
desk and you attempt to store it in another desk, Aporia takes the tool out of the old desk
and puts it in the new one. You can, however, make a copy of a tool and store that copy
in a different desk. That way, you can have the same tool in two different desks. See
“Copying Tools,” earlier, for a description of how you can make a copy of a tool.

You can also store one desk within another. To do this, simply drag the Desk Tool you
want to store on top of its parent Desk Tool, then select OK to confirm the operation. The
next time you double-click on the parent Desk Tool, Aporia will remove the child Desk
Tool from the desktop and store it in the parent Desk Tool.

0 Put Tool into Desk drawer?

OK Cancel

Figure 16-5 Aporia allows you to organize your tools by storing them in desks
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As mentioned, you can double-click on a Desk Tool to have the tools it contains
displayed on your desktop. However, when one desk is stored within another, opening
the parent desk serves only to display the tools contained in that desk. This includes other
desks it may contain. To see the contents of a “child desk,” you must double-click on it

separately.

Customizing Tools

Aporia provides an extensive system for customizing the appearance and operation of
tools. To customize a tool, grab that tool with your mouse and drag it on top of Aporia’s
Opt (Options) Tool. Aporia displays the dialog box shown in Figure 16-6. By modifying
the contents of this dialog box, you can set options for the current tool. Briefly, the
following options are available:

® Displayed Name: Displays the name that is currently assigned to the tool. However,
you can type a new name of up to 30 characters. You might use this feature to change
the name of a Desk Tool so that you can differentiate it from other Desk Tools. You
might also want to use this feature to assign more descriptive names to your data

o Options Tool
FPicture
Displayed Name: rProgranm
I““‘P I Program/File:
FShow... ]
Desk I |
X 1con pirectory To Run In:
= X Hame
o
» O Default Arguments:
Image File Put 77 to be prompted
for arguments.

[Ho tes & Nl B
Notes File: Running...

| 0
rote Editing Program: ] [J No chdir Before

[JRun on Start-up

Help File:

I [J Run Desk's Contents

Help Display Program:

[cancer | [ ok |

Figure 16-6 Aporia allows you to set options for its tools
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file and application tools. For purposes of display, this feature, in effect, allows you
to overcome the eight character limit that is imposed on you by DOS.

® Show: Lets you change the appearance of the current tool. The Icon, Name, and Dir
check boxes control the display of the icon for the tool, its description, and its
directory (Directory Tools only). For example, if you clear the Icon check box, only
the name of the tool will be displayed.

® Image File: Allows you to specify the name of an image file (bitmap) you want to
use in place of the current one. When you installed Aporia, it copied a series of
Aporia Image Files (files with a .AIF extension) for different applications to an
\APORIA\IMAGES directory. You can type the name of any one of these image
files to have it displayed as the icon for the current tool. When you type the name
if an image file, Aporia will search for that file in the \APORIA\IMAGES directory.
If it finds the file, Aporia will display it in the Displayed Icon window to the left.
Alternatively, you can create your own image file and specify its name in the Image
File text box. See the next section, “Creating Image Files,” for details on how you
can create your own Aporia Image Files.

® Notes File: Later, under “Keeping Notes,” you'll learn how you can use the Notes
Tool to have Aporia start a text editor—for example, Notepad—and load a file into
that editor that displays notes for the current tool. This text box allows you to specify
the name of the file that will be loaded. If you are changing options for a user tool,
you must prepare this file yourself before actually using it.

® Note Editing Program: Lets you specify the file name of the text editor that will be
used to display note files for the current tool. This editor will be used when you
drag the current tool onto the Notes Tool. A common choice for a text editor is
NOTEPAD.EXE.

® Help File: This box is only used for User Tools. Nevertheless, you can use this box
to specify the name of a help file you want Aporia to load when you drag this icon
onto the Help Tool. You must prepare this file yourself in advance.

® Help Display Program: The executable filename of a text editor that will be used
for help files. A common choice here is NOTEPAD.EXE.

® Program/File: If you are changing options for a User Tool that starts an application,
this text box shows the path and name of that application’s executable file. You can
change the current entry to show the path and name of another application, if you
so desire. This lets you completely change the character and function of the current
tool without having to delete an old tool and create a new one.

® Directory To Run In: If you are changing options for a User Tool that starts an
application, this text box shows the directory in which that application resides.
However, you can change this entry to have a specific directory made current when
you start the application.

® Default Arguments: If you are changing options for a User Tool that starts an
application, this text lets you pass parameters to the application. For example, if




Aporia 619

you want a specific data file to be loaded each time you start the application, you
enter the path and name of that data file in this box. If you place two question marks
(??) in this box, Aporia will prompt you for the parameters when you start the
application.

® Default: You can use this check box to select from one of three different modes for
running an application: Default, Fullscreen, or Iconic. Clicking repeatedly will
cycle you through each of these three options. If you select Default, Aporia will run
the application in a window whose default size and position is set by Windows or
by the Size Tool. If you select Fullscreen, the application will run in a maximized
window. If you select Iconic, Aporia will start the application and immediately
minimize it to an icon.

® No Chdir Before: Instructs Aporia to ignore any entry in the Directory To Run In
text box. You might use this check box when you want an application to start up in
its own directory.

® Run On Startup: Runs the current tool whenever you start Aporia. This check box
allows you to run a specific application whenever you start Aporia.

® Run Desks Contents: If you are setting options for a Desk Tool, this check box
allows you to specify that all the tools in a desk be run when you double-click on
the Desk Tool. This check box provides a convenient way to set up a work session
that requires the use of multiple applications.

Note: You canset general parameters that apply to all of Aporia’s tools by double-click-
ing on the Opt (Options) tool. When you do this, Aporia displays a dialog box
that lets you modify many of the default settings both for its tools and for its
general operation. These include such features as the maximum tool size in pixels,
the font, size and color used for the names of Directory and User Tools, the status
of trash management, and the text editor used to display Help and Notes files.

Creating Aporia Image Files

Aporia comes with a utility called Image Maker that lets you capture screen elements and
save them as Aporia Image Files (.AIF bitmap files). Once you have saved an .AIF file,
you can display it as an icon for one of Aporia’s Tools.

The Image Maker utility allows you to capture an icon, an area of the screen, or an
entire window and save it as a .AIF file. Therefore, you can borrow an icon from another
application and save it is as a .AIF file, or you can create your image with a draw
package—for example, Paintbrush or Icondraw—and save it as an .AIF file.

To run the Image Maker utility, use the Tree Tool to open the Directory window and
then double-click on the directory containing Aporia. Aporia opens up a Directory
window showing the names of files in that directory. Find the file IMAGEMKR.EXE
and double-click on it. Aporia opens the Image Maker utility window shown in Figure
16-7. Minimize this window to an icon for now.
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Figure 16-7 The Image Maker window

To create an Aporia Image File, begin by deciding on an area of the screen you want
to capture. It can be an icon from another Windows application or an image you have
created in Paintbrush. When you are ready, restore the Image Maker window by
double-clicking on its icon. Then, open the Capture menu. Aporia displays a pull-down
menu with the following options:

® Area: Lets you capture an area of your screen. When you select this option, Aporia
changes the shape of the mouse pointer to a crosshair. Click on the upper-left comer
of the area you want to capture and hold your mouse button down. Then, drag to
the lower-right corner of the area. As you drag, Aporia builds a box around the area
of the screen you've selected. When you are ready, release your mouse button.
Aporia copies the area of the screen you have selected to the Image Maker window.
You might use this option to select an image that you have created in Paintbrush.
However, try to keep the area you capture small—about one inch by one inch. When
Aporia copies the image to the Image Maker window, it shrinks it to a 32 x 32 pixel
size. If the copied image is larger than this, it may become distorted when its size
is reduced.

® Icon: Lets you capture an icon from another application. When you select this
option, Aporia changes the shape of the mouse pointer to a large vertical arrow.
Click on any icon that is displayed on your screen. Aporia copies that icon to the
Image Maker window.

e Window: Lets you capture an entire window. When you select this option, Aporia
changes the shape of the mouse pointer to a large vertical arrow. Click on any
window that is displayed on your screen. Aporia copies an image of the window
you’ve selected to the Image Maker window. Aporia reduces the size of that image
to make it small enough for use as an icon (approximately 32 x 32 pixels). This
tends to distort the image of the window.
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Once you have captured an icon, an area of the screen, or a window, you are ready to
save that image to an .AIF file. To do this, select the File Save command from Image
Maker’s window. Aporia presents a dialog box that allows you to assign a name to the
file. Type a name of eight characters or less and make sure you use the .AIF extension.
When you select OK or press ENTER to confirm the filename, Aporia saves the file to
the \APORIA\IMAGES directory.

To have your new image file displayed as an icon for one of your User or Directory
Tools, drag that tool on top of the Opt (Options) Tool. Aporia displays the Options Tool
dialog box shown earlier in Figure 16-6. This dialog box displays the settings for the
current tool. Type the name of your new Aporia Image File in the Image File text box.
Aporia displays the image in the Displayed Icon window to the left. Select OK to return
to Aporia and have your new image file displayed as an icon for the current tool.

Note: As mentioned, your new image file may appear distorted because Aporia has
reduced its size. You may be able to improve on its appearance, though, by
increasing the displayed size of Aporia’s tools. To do this, double-click on the
Opt (Options) icon to have Aporia display the General Options dialog box and
select the Set Tool Size push button. Aporia displays a second dialog box that
displays the value 32, meaning 32 x 32 pixels. You can increase this value as
high as 99 pixels, thereby tripling the displayed size of all of Aporia’s tools.

The Image Maker window offers two other menu options that you may find useful.
For example, you can use the File Load command to open an image file. This allows you
to check what is in a specific image file when you cannot remember. The Options menu
contains a single option, Displayed Size, that lets you set the displayed height and width
of the current image in pixels.

Getting Information about a Tool

You can easily get information about any tool that is displayed on the desktop. To do this,
simply double-click your right-hand mouse button on that tool. Aporia displays the dialog
box in Figure 16-8. This dialog box contains information about the tool itself as well as
the desk in which it is stored.

Hiding Tools

You can use Aporia’s Hide Tool to hide individual tools temporarily. This allows you to
avoid a cluttered desktop. To do this, drag any tool, except a Desk Tool, onto the Hide
Tool. That tool then disappears from your screen. You can easily restore that tool to the
desktop at a later time by double-clicking on its Desk Tool.

Keeping Notes

Aporia allows you to maintain a note file for any tool on the desktop, which provides a
powerful method of documenting your applications and data files. To do this, drag any
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= Aporia - Tool Info
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Figure 16-8 You can double-click your right mouse button on a tool to get infor-
mation about it

tool on top of the Notes Tool. If a notes file already exists for that tool, Aporia will open
Notepad and load that file. If a notes file does not already exist, Aporia will inform you
of this by displaying a message box. When you select OK to clear this message box,
Notepad takes over and asks you if you want to create a file with the name that begins
with the name of the current tool followed by a .TXT extension. Select OK to create the
file. You can then type any notes you may feel are pertinent to the current tool. When
you are done, use the File Save command to save the file, and close the Notepad window
to return to Aporia.

Removing Tools

Suppose you’ve created a tool you no longer need and you want to permanently remove
that tool from the desktop. To do this, simply grab that tool with your mouse and drag it
on top of the Trash Tool. Aporia displays a Yes/No message asking you to confirm the
deletion. If you select Yes, Aporia displays a second Yes/No/Cancel message box asking
you if you also want the file associated with that tool deleted from your hard disk. If you
select Yes, Aporia removes the tool from the desktop and deletes its associated file on
disk. If you select No, Aporia simply removes the tool from the desk top and leaves the
file on disk alone. Finally, if you select Cancel, Aporia cancels the delete operation
altogether and neither the tool nor its associated file is affected.
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When you use the Trash Tool to delete a file on your hard disk, and trash management
is enabled (the default), Aporia doesn’t delete it right away. Instead, it moves the file to
a special directory (\(APORIA\!TRASH). That way, you can recover the file if you need
to. However, if you quit Aporia or leave Windows before recovering the trashed file, the
\TRASH directory is cleared and the file is lost.

To reclaim files from the \!TRASH directory, double-click on the Trash Tool. Aporia
displays a dialog box with two push buttons, Restore Files and Empty Trash. If you select
Restore Files, Aporia opens a Directory Window displaying the files in the Trash
directory. You can then copy the files you want to save to another directory. See “Copying
Files” later under “Managing Files with Directory Windows"” for details on how you can
copy files from one directory to another. On the other hand, if you select the Empty Trash
push button, Aporia will remove all files in the \|TRASH directory, deleting them
permanently from your hard disk.

Using the Size Tool

The Size Tool lets you control the size and position of application windows. To use this
tool, first use an existing tool to start a Windows application. Once that application is
open, adjust the size of its window to meet your needs. When you are ready, drag the
application tool of your choice onto the Size Tool. Aporia displays a Yes/No/Cancel
message box. If you select Yes, the message box is cleared and an icon is displayed that
follows the movement of your mouse pointer. Click on the title bar of the application
window whose size you have just finished adjusting. Aporia assigns the sizing for the
window you've selected to the current tool. The next time you use that tool to start an
application, Aporia will adjust the size and position of the application’s window to meet
the specifications you've defined.

To remove sizing from a tool, simply drag that tool onto the Size Tool. Aporia displays
the Yes/No/Cancel dialog box. Select No to clear the sizing settings for the current tool.

MANAGING FILES AND DIRECTORIES

Like the Windows File Manager, Aporia allows you to manage files and directories. For
example, you can create new directories, delete old ones, or rename directories. You can
also copy, move, rename, and delete files.

To manage files and directories with Aporia, you can use a combination of the Tree
tool and Directory windows. The Tree tool allows you to manage directories, and
Directory windows allow you to manage files.

Managing Directories with the Tree Tool

To manage directories with Aporia, you use the Tree Tool. When you double-click on
this tool, Aporia opens the Directory Tree window, shown earlier in Figure 16-1. This
window contains a graphical representation of the structure of the directories on the
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current drive. The root directory, usually C:\, appears highlighted. To make another
directory current, simply click on the name of that directory in the directory tree.

The Directory Tree comes with its own menu that you can use to manage the directories
on your hard disk and to create Directory Tools for the Aporia desktop. The sections that
follow show you how to go about using these commands.

Changing Drives

You can use the Drives menu to select from the different drives on your system. When
you select this menu option, Aporia displays a pull-down menu showing the letters of the
drives that are available on your system. (If you are connected to network drives, those
drives appear in the list as well.) When you select a drive, Aporia updates the Directory
Tree window to show the directories on that drive. The root directory for the drive you’ve
selected appears highlighted in the directory tree. You can, of course, click on the name
of any directory in the directory tree to make that directory current.

Using the Directories Menu

The Directories menu lets you create a new directory, delete an old one, or rename a
directory on the current drive. Before using this menu option, select the name of a
directory from the directory tree below. Any operation you perform with the Directories
menu will then apply to that directory.

To create a new subdirectory for the current directory, select the Create option from
the Directories menu. Aporia displays the dialog box shown in Figure 16-9. Type the
name for the new directory and select OK or press ENTER to create it.

To delete the directory that is currently on the directory tree, select the Delete option
from the Directories menu. Aporia displays a dialog box asking you to confirm the
deletion. Select OK to delete the directory.

Note: Aporia will not allow you to delete a directory that contains either files or
subdirectories. Therefore, if you want to delete such a directory, you must first
delete the files or subdirectories it contains. See “Deleting Files™ later under
“Managing Files with Directory Windows" for information on how you can use
Aporia to delete the files in a directory.

Create Directory: [l

Enter a directory to be created under the
currently highlighted directory.

Figure 16-9 Aporia allows you to create new directories
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To change the name of the directory that is currently selected on the tree, select the
Rename option from the Directories menu. Aporia displays a dialog box with two text
boxes entitled Rename and To, respectively. Only the To box is enabled, and the name
of the current directory appears in the Rename box. Type the new name for the directory
in the To box and press ENTER or select OK. Aporia renames the directory with the new
name you’ve specified.

Using the Options Menu

The Options menu allows you to display a Directory window that is linked to the
Directory Tree window. Whenever you click on a new directory in the Directory Tree
window, the linked Directory Window is updated to display the files in that directory. To
create a Directory window of this kind, open the Options menu in the Directory Tree
window. This menu contains a single option, Directory Window. When you select this
option, Aporia opens a Directory window that is linked to the currently displayed
directory tree. When you open a Directory window that is linked to the directory tree,
that window is displayed immediately to the right. Further, when you move the Directory
Tree window, its associated Directory window moves along with it.

Using the Special Menu

The Special menu contains three options, Make Directory Window, Make Directory Tool,
and Disk Information. These options allow you to perform the following functions:

® Make Directory Window: Lets you open a Directory window for the currently
selected directory in the directory tree. However, that Directory window is not
linked to the directory tree. As an alternative to this command, you can simply
double-click your left mouse button on the name of a directory in the directory tree.

® Make Directory Tool: Lets you create a directory tool that represents the directory
currently selected on the directory tree. Once that tool exists, you can use it to open
a Directory window for that specific directory whenever you want. The use of this
option is discussed in more detail above in the section on “Creating Directory
Tools.” As an alternative to this command, you can double-click your right-hand
mouse button on the name of a directory in the directory tree.

e Disk Information: When you select this option, Aporia displays a dialog box that
shows you the total capacity of the current drive, the total amount of free space on
that drive, and number of directories it contains.

Managing Files with Directory Windows

To manage files with Aporia, you must use a Directory window. As you know, Directory
windows are used to display the files in a specific directory. In addition to displaying a
list of files, though, Directory windows include a menu system that allows you to manage
the files in the current directory. This section familiarizes you with the available menu
options and how you can use them to manage files from within Aporia.
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Opening Directory Windows

Aporia allows you to open Directory windows in several ways. On the one hand, you can
use the Tree tool as described earlier to open the Directory Tree window. Once that
window is displayed, you can double-click on the name of any directory to open a
Directory window for that directory.

As an alternative to using the Tree Tool, you can use Aporia’s Dir (Directory) Tool.
When you double-click on this tool, Aporia opens a Directory window, as shown earlier
in Figure 16-4. Normally, Aporia only displays the names of files in a Directory window.
However, when you use the Dir Tool to access a Directory window, additional informa-
tion is displayed for each file including its size in bytes, its date and time of creation, and
any attributes that may be assigned to the file. You can have any Directory display your
files in this way by using the View Long command. See “Using the View Menu” later
for more details on this command.

A Directory window accessed with the Dir Tool shows the contents of the current
directory. When you start Aporia, the current directory is your root (C:\) directory.
However, you can change the current directory for Aporia by using the Tree Tool to open
the Directory Window and selecting the name of the directory from the directory tree.
The contents of the directory you select will be displayed in the Directory window that
you open with the Dir Tool.

Note: You can also create a directory tool for a specific directory. That way you can
open a Directory window for a specific directory, other than the current directory,
whenever you want to. See “Creating Directory Tools” earlier in this chapter for
more details on this.

Selecting Files

Most of the commands offered in the Directory window menu require that you select one
or more files to which the command will apply. You can select a single file from a
Directory window by clicking on its name. When you click on the name of a file, Aporia
moves the highlight to that file, indicating that it is selected. To select multiple files
scattered throughout a Directory window, hold down the CTRL key and click on each of
the files you want to select. To select a group of files, hold down the SHIFT and click on
the first and last items in the group. To select all the files in a Directory window, choose
the Special Select All command from the Directory window menu.

Running Applications

To run an application, you can select the File Run command from the directory-window
menu. When you select this command, Aporia presents a dialog box prompting you for
the name of the file you want to run. Type the name of an executable file and select OK
or press ENTER to run the file. As an alternative to using the File Run command, you
can simply double-click on the name of an executable file in a Directory window to have
Aporia run that file.
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Note: You can also create a User tool for an application and have it displayed on the
Windows desktop. Once that tool is displayed, you can double-click on it to run
the application. See “Creating User Tools” earlier in this chapter for details on
how to do this.

Copying Files

In Aporia, you can copy files in one of two ways. On the one hand, you can use the File
Copy command from the Directory window menu. On the other hand, you can use your
mouse to copy a file from one Directory window to another.

To use the File Copy command to copy a file, first select the name of the file you want
to copy from the current Directory window, then select File Copy. Aporia displays a
dialog box with two text boxes entitled Copy and To, respectively. The name of the
currently selected file appears in the Copy box. In the To text box, type the path and name
of the directory that you want to copy the file to. (You can also specify a new name for
the file if you want.) To execute the copy, select OK.

As an alternative to the File Copy command, you can use your mouse to simply drag
the name of a file from one Directory window to another. To do this, both the source and
destination Directory windows must be open on the desktop. Click your left mouse button
on the name of the file in the source Directory window and drag it to the destination
Directory window. (When you begin to drag, Aporia transforms the shape of the mouse
pointer to an icon.) When you are ready, release your mouse button. Aporia displays a
dialog box asking you to confirm the copy. Select OK to complete the copy operation.

Note: You can also copy a file to a directory by dragging the tool for a data file onto a
Directory Tool.

Moving Files

You can also move files from one directory to another by using the File Move command
or by dragging with your mouse. To use the File Move command, begin by selecting the
name of the file you want to move from the current Directory window. When you are
ready, select the File Move command. Aporia displays a dialog box that contains two text
boxes entitled Move and To, respectively. The name of the currently selected file appears
in the Move box. In the To text box, type the name of the directory to which you want to
move the file. To execute the move, select OK.

You can also move a file by dragging it from one Directory window to another with
your mouse. Obviously, both the source and destination Directory windows must be open
before you attempt this operation. Once both windows are open, click your right-hand
mouse button on the file you want to move in the source window, then drag that file to
the destination window and release the mouse button. (As you begin to drag, Aporia
transforms the shape of the mouse pointer to an icon.) Aporia then displays a dialog box
asking you to confirm the move. Select OK to complete the move operation.
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Renaming Files

You can also change the name of a file by using the File Rename command from the
Directory window menu. First, however, select the file whose name you want to change
from the list of files in the current Directory window. When you are ready, select the File
Rename command. Aporia displays a dialog box that contains two text boxes labeled
Rename and To, respectively. The name of the currently selected file appears in the
Rename box. Type the new name for the file in the To text box and press ENTER to
rename the file.

Deleting Files

To delete a file from your hard disk, you can either use the File Delete command from
the Directory window menu or use your mouse to drag the file to the Trash Tool. To use
the File Delete command, begin by selecting the file from an open Directory window.
Once you have made your selection, select the File Delete command from the Directory
window menu. Aporia displays a dialog box asking you to confirm the deletion. Select
OK to delete the file.

To delete a file by using your mouse, click on the name of that file in an open Directory
window and drag it to the Trash Tool. Aporia displays a dialog box asking you to confirm
the deletion. Select OK to delete the file. Aporia copies the file to its \APORIA\!TRASH
directory located on the drive on which you've installed Aporia. That way, you can
recover the file if you later change your mind. See “Removing Tools™ earlier on this
chapter for details on how you can recover files from the \'TRASH directory.

Using the View Menu

You can use the View option from the Directory window menu to control how the
contents of a Directory window are displayed. For example, you can change the order of
the files in the current Directory window. You can also limit the list of files displayed to
a specific group that you select. When you open the View menu, the following options
are available:

® Long: Causes the current Directory window to show all information that is available
for each file, including the file's name, size in bytes, date and time of creation, and
the attributes that are currently assigned to the file.

e Short: Causes only the names of files to be displayed in the current Directory
window. All other information about the files is suppressed. (This is the default
setting.)

® All: Causes all the files in a directory to be displayed in the current Directory
window.

e Partial: Displays a dialog box that lets you specify one or more groups of files to
be displayed in the current Directory window. In the text box provided, enter one
or more file specifications that describe the group(s) of files you want to display.
Separate each file specification with a space. For example, to display only those
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files with a .BMP or .WRI extension, enter *, BMP *.WRI. Select OK to imple-
ment the change.

® Programs: Displays only those files in the current directory that have a.EXE, .COM,
or .BAT extension.

® By Name: Sorts all displayed files alphabetically by name (the default).

® By Size: Sorts all displayed files by their relative size, working from smallest to
largest.

® By Date: Sorts all displayed files by date and time of creation, working from newest
to oldest.

® By Kind: Sorts all displayed files alphabetically by file extension.

® Update: Causes Aporia to reread the directory that is currently displayed in a
Directory window. You might want to use this option if you are working on a
network. For example, imagine another user has added a file to the current directory
without your knowledge. To make sure you are using the most up-to-date informa-
tion, you can have Aporia reread the current directory and refresh the files list for
the current Directory window.

Using the Special Menu

The Special menu contains commands that let you create user tools, select files, and get
information about the size of a group of files. The following options are available on this
menu:

® Make User Tool: Creates User Tools for the files that are selected in the current
Directory window. See “Creating User Tools” earlier in the chapter for more details
on how to use this option.

® Make Directory Tool: Lets you create a directory tool for the directory that is
displayed in the current Directory window. See “Creating Directory Tools™ earlier
in this chapter for more details on how to use this option.

® Select All: Selects all the files in the current Directory window. You can then issue
a command that affects all the files in the directory.

® Disk Space Used: When you select this option, Aporia displays a dialog box that
shows you the total size in bytes of all the files that are selected in the current
Directory window.

SUMMARY

This chapter provides a brief overview of the commands and options that are available
from Aporia. You now know enough about Aporia to get you started. For example, you
now know how to create User Tools and Directory Tools that represent the applications,
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data files, and directories on your hard disk. You can use these tools to start applications
as well as view the files in a given directory whenever you want.

You also know how to use Aporia to manage directories and files on your hard disk.
For example, you now know how to copy, rename, or delete directories and files. If you
want, you can now begin using Aporia as your gateway to Windows.



